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Session Information

* Today’s Session Length: Approximately 2 hours.
* Session Structure: Presentation with hands-on practice opportunities
* Today's session will be conducted using

— Blackboard Collaborate,

— Microsoft Office 365 Desktop Applications

— Notepad

Disclaimer: The content in this presentation was prepared for informational purposes only.
The information contained herein is not intended to constitute legal advice and you should
consult with your own attorney when developing your online accessibility program and
policy. Blackboard assumes no liability in connection to this presentation and any
information contained here in.



Today’s Topics

Review Common Accessibility Issues for Digital Resources

Analyze MS Office File Issues reported by Ally

Demonstrate How to Access Instructor Feedback

Evaluate and improve the Ally Score for a
— MS Word Document
— MS PowerPoint Presentation

* Compare and Contrast Instructor Feedback results



Common Accessibility Issues for Digital Resources

* Improper use of headers.

* Incorrectly built lists.

* Empty links or links without descriptive text.

* Missing alternative text tags in images.

* Using tables incorrectly.

* Uploaded Files/Documents that are not built accessibly.
* Color contrast issues.

* Readability

* Videos missing closed captioning or no transcript

Note: The Web Content Accessibility Guidelines are authored and implemented by the US Office of Civil Rights.



What does ALLY scan for in MS Office Files?

Office document checklist - This includes Microsoft® Word, Microsoft® PowerPoint®.

Images without Alt Text * No language set or
Contrast issues incorrect language set
Missing headings

Inappropriate heading

structure

Headings does not start

at 1 or exceeds 6

Tables without headers

 Malformed



Improve for the Ally Scan and WCAG Guidelines

MS Word

Improper use of headers.

Missing alternative text tags in images.
Using tables incorrectly.

Color contrast issues.

Incorrectly built lists.

Empty links or links without
descriptive text (screentip).

PowerPoint

Improper use of headers and slide titles.
Missing alternative text tags in images.
Using tables incorrectly.

Color contrast issues.

Incorrectly built lists.

Empty links or links without
descriptive text (screentip).



Instructor Feedbac

A 1. Document: The document has contrast issues 3

A 3. Document: The document has tables that don't have any headers 4

A 2. ocument The docunent conains mages vinou 2 descrin . >

8 4. Document: The document does not have a language set 4 . .
A The document has contrast issues Items with this accessibility issue
These documents contain text with low contrast between the text and its background. This can cause the text to be difficult to 6
A 5. Document: The document is untagged 4 . read, especially for those with low vision, poor eyesight or colour blindness.
[u 6. Document: The document is missing a title 2 . Items with this accessibility issue

B Sample Word Document printing .pdf 6%
PDF document N

Text fragments with
insufficient contrast

Page 1 of 1 Accessibility score for:

Sample Word Document printing
.pdf

- ssible Content
lackboard WEM Content Allissues €

2

7

Add built-in Headings to document and do not skip numbers (¢.g. jumping from Heading 1 to Heading 3)
use built-in List optians (e.g. bullats or numbers]
Links should be descritive toxt

This PDF is untagged

Fix
Add Al Text for all images o,
Define Table Headers and simplify Tables as much as possible ITEEEe CRm I D s
This PDF does not have a
Guidance
language set N
coming soon

Increase score up to 10%

Helpful Information This PDF contains text
with insufficient contrast Fix

Increase score up to 7%

alackboard Accessibility Help Site -
https://help.blackboard.com/Web_Community Mar




Workshop Resource Webpage

Download the sample files:
* Word Document

* PowerPoint

AMPLIFY ALLY SCORE AMPLIFY YOUR ALLY SCORE FOR MS WORD AND POWERPOINT SAMPLE FILES
- MS Word and Powerpoint o Review Common Accessibility Issues for Digital Resources ‘Word Document ¥4
: o Analyze MS Office File Issues reported by Ally @ PowerPoint YA
+ Google Docs and Slides = Demonstrate How to Access Instructor Feedback

o Evaluate and improve the Ally Score for a
= MS Word Document
= MS PowerPoint Presentation
« Compare and Contrast Instructor Feedback results

Office 365 Office 2019 Office 2016

* Adobe Pro

Workshop Website
https://tinyurl.com/AmplifyAllyMSOffice

SESSION DOCUMENTATION

[ Presentation ¥4

€

Blackboard Help



https://sw00000004.schoolwires.net/domain/2167

MS Word

v" Open the Word Doc

v" Show Ribbon and Tabs

File Home Insert Design Layout References Mailings Review View Help Acrobat

=" ZE 7l T | nabcede AaBbCeD: AZBHC( AaBbCeL i

Eﬁ A Calibri (Body) ~ 24 ~ A" A Aa~ Ao =
== = & HE TMormal | TMo Spac.. Heading1 Heading 2

v’ Initiate Accessibility Checker Rl ENTIGNINEY WSy

Clipboard T Font ] Paragraph ] Styles

Check
Accessibility

Accessibility

10




Microsoft Accessibility Checker

Errors Warnings Tips
e Very difficult or * In most cases but not * Content that can be
impossible for people all content is difficult to accessed but could be
with disabilities to access. better organized or

access. presented .

11



Contrast

Creating Accessible Content

Chacklist for Blackboard WCOM Content

Add built-in Headings to document and do not skip numbers (e.2. jumping from Heading 1 to Hezding 3)
Use built-in List options [e.2. bullets or numbers)

Links showld be descriptive text

add al Text for all images

Define Table Headers and simplify Tables a5 much as possible

* Low contrast can make content difficult to read

* Check contrast for WCAG AA rating (4.5:1 Ratio)

12



Heading Structure

* Breaks up longer content

AaBbCeDdEe | |AaBbCcDo| |AaBbCcDdEe| | AaBbCcDdEe

Mo Spacing Heading 1 Heading 2 Heading 3

* Allows screen reader to navigate ==l
quickly from heading to heading. a

* Use ONLY for logical structure NOT This is a Heading 1 style
SiZing. This is some text.

* Only titles and subtitles should be Ths e a eading 2 Se
marked as headings, NOT body text.

* Use Styles in MSWord to create
headings. The format of each may be
modified and saved.

13



Sample Document with Headings Applied

Document Title (Heading Style 1)

Topic 1 (Heading Style 2)
Normal Paragraph Style: Bacon ipsum dolor amet venizon meathall spareribs pork
beef ribs flank chicken. Shoulder strip steak proscintto short loin picanha. Brisket
pork loin eupim romp, shankle aleatra biltong t-bone bacon buffals tongus
sausage chicken piz. Sausage ground round chicken corned beef pig frankfurter
bacon jerky ham salami picanha proscintto.

Topic 2 (Heading Style 2)
Subtopic & [Heading Style 3)
Normal Paragraph Style: Buffalo lorem turkey ut nisi chicken prosciutio voluptate
laboram tri-tip dolore biltong proident ham pork loin. Spareribs kislbasa aliguip
nulla, quis dolore kevin chicken nisi ribeve bresacla t-bone laboriz. Hambarger
mollit voluptate, rump est pancetta labore anim porchetta. Lorem rump ut ham
ut tenderloin ante, Aute picanha shank enpim dolore, brizkst pancetta.

Subtopic B (Heading Style 3)

Normal Paragraph Style: Buffalo lorem turkey ut nisi chicken prosciutio voluptate
laboram tri-tip dolere bilbong proident ham pork loin. Spare ribs kelbasa aligoip
nulla, quis dolore kevin chicken nisi ribeve bresacla t-bone laboriz. Hamburger
mollit voluptate, rump est pancetta labore anim porchetta, Lorem rump ut ham
ut tenderloin ante. Aute picanha shank copim dolore, brizket pancetta.

Topic 3 (Heading Style 2)
Normal Paragraph Style: Buffalo lorem turkey ut nisi chicken prosciutto voluptate
laborom tri-tip dolore biltong proident ham pork loin. Spare ribs kielbasa aliquip
nulla, quis delore kevin chicken nisi ribeye brezacla t-bone laboris. Hambuarger
mollit voluptate, rump est pancetta labore anim porchetta. Lorem rump ut ham
ut tenderloin ante. Aute picanha shank copim dolore, brizket pancetta.

14



Sample Document with Headings and Table of Contents

Table of Contents
Document Title |<eading Style 1), 1
Topic I [Heading 3oyvke: 2] 1
Topic 2 [Heading Syke: 2] 1
Subtopic & |Heading Style 3) 1
Subtopic B (Heading Style 3| 1
Topic 3 [Heading Sty 2 1

Document Title (Heading Style 1)
Topic 1 {Heading Style 2)

sarmal Paragraph Style: Bacan ipsum dalor amel venison meatball spareribs pork
beef ribs flank chicken. Shoalder strip steak prosciatto shoet kin picanha. Briske
pork lain eopim rump, shankle aleatra biltong t-bose bacon baffale tongee
sasage chirken pig. Sausage ground roamd chicken comed beef pig frankfarter
hacon jerky ham salami picanha prosciatio.

Topic 2 (Heading Style 2)
Subtopic A (Heading Style 3
starmal Paragraph Style: Buffale lorem tarkey ut ndsi chicken prosciutio voluptate
labarum tri-tip dolore biltong proident ham pock lin. Spareribs kielhasa aliquip
nulla, quis dalore kevin chicken nisi ribeye bresaola t-booe laboris. Hamburger

mallit voluplate, rump est panceita lnbore anim parchetta. Loeem rumap ok bam
ut tenderain ame. Aute picnnha shank rupim dolore, hrisket pameetia.

Subtopic B [Heading Style 3)

starmal Paragraph Style: Buffalo brem tarkey ut ndsi chicken prosciutio voluptate
labanuma tri-tip dolore biltong proident ham pack kin. Spare ribs kielhasa aliquip
nulla, quis dalore kevin chicken nisi ribeye bresaola t-booe laboris. Hamburger
mallit voluplate, rump est paneettn labore anim parchetia. Lorens nemp of bam
ut tenderoin ame. Aute picnnha shank cupim dolore, brisket pancetia.

Topic 3 (Heading Style 2)
starmal Paragraph Style: Buffalo brem tarkey ut ndsi chicken prosciutio voluptate
labanuma tri-tip dolore biltong proident ham pack kin. Spare ribs kielhasa aliquip
nulla, quis dalore kevin chicken nisi ribeye bresaola t-booe laboris. Hamburger
mallit voluplate, rump est paneettn labore anim parchetia. Lorens nemp of bam
ut tenderoin ame. Aute picnnha shank cupim dolore, brisket pancetia.
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Modify
Heading Styles

(Windows)

Maodify Style 7 X

Properties
Mame: Heading 1
Style type: Linked (paragraph and character) -':I
Style based om: ¥ normal E
Style for following paragraph: T Normal Z
Formatting
Calibri Light (Headir[~| 24 ¥| B 7 U | I -
E B = = = = = = B = 3=
Creating Accessible Content
Fant: (Default) +Headings (Calibri Light), 24 pt, Bold, Font color: Accent 1, Centered A

Line spacing: 1.5 lines, Space
Before: 12 pt

after: 0 pt, Keep with nest, Keep lines together, Level 1, Style: Linked, Show in the Styles gallery,
Add to the Styles gallery [ Aytomatically update
@ Only in this document O MNew documents based on this template

Format = OK

16



Modify
Heading Styles

WYE)

Modify Style

Properties

Name: | Heading 1

Style type:  Linked (paragraph and character)

Style based on: 1 Mormal
Style for following paragraph: 1 Normal

Formatting

.
m
-
=

Calibri Light (Headi... ~+ 24

Latin

1l
hi
11
H
v
ii
T
Il
4
i
Iﬁl
Iﬁl

Sample Text Sample Text Sample Text Sample
Text Sample Text Sample Text Sample Text
Sample Text Sample Text Sample Text Sample

Font: (Default) +Headings (Calibri Light), 24 pt, Font color: Accent 1,
Complex Script Font: +Headings CS (Times New Roman), 16 pt, Left-to-
right, Space
| Add to template

Add to Quick Style list

| Automatically update

Format n Cancel

17



Design Layout References Mailings Review View Help

w

Calibri (Body) ~|11 ~ A" A" Aa~ B AaBbCcDc AaBbCcDe AaBbCx

B I U~ax x A~ & A. T MNormal | THo Spac.. Heading 1

Font I Paragraph l Styles

Use Built-In Feature

Requires Paragraph Return (not line return)

Consider “Numbering” when order matters

Consider “Bullets” when order doesn’t matter

Note: Using built-in list tools is recommended when creating accessible lists.

18



Insert Hyperlink

Link to: Text to display: |Blackboard Accessibility Help Site

E;isti';-lgﬂﬁh 5 Look in: & This PC

i 8 Downloads : =
| Current Folder | = Pictures
Place in This & Music e —
Document m Desktop
= Browsed Pages| 4 Documents
A B Videos
Create New
Dacument & DCShares
Regent Files |=" 0SDisk (C:)
d
E-mail Address

Address: https://help.blackboard.com/Web_Community_Manager,/Administrato rmccessii:rilttﬂ W |

e

* Links should be clickable descriptive text.
— Avoid URL as the text and “click here”.
* Making clickable text longer.

*  ScreenTip - consider adding text that describes the link
(Do not repeat linked text).

Note: Using the screentip is a recommended when creating accessible.

19



Insert Hyperlink

I_I N kS ( M d C) Text to Display:  Creating a URL
This Document Email Address |

Link to an existing file or web page.

Address: | | Select...

Cancel

* Links should be clickable descriptive text.
— Avoid URL as the text and “click here”.
* Making clickable text longer.

* ScreenTip - consider adding text that describes the link
(Do not repeat linked text).

. . . . . 20
Note: Using the screentip is a recommended when creating accessible.



Images

Alt Text allows assistive technologies to convert images into words.

Guidelines for Images:

* Avoid unrelated images or mark as Decorative

* Images must be in-line with text.

* Alt Text should be clear, concise, and descriptive. (1 — 2 Sentences)
* Avoid using the same text for every image.

* Don’tinclude “image of...” or “picture of...” as part of alt text

* |f the image is an infographic you should use alt text to provide the information
conveyed in the object.

21



Infographics

* Add Alt Text
* Include content from the infographic into the content.

Blackboard

I am so happy Blackboard Is here to

assist me with my webslite planning

Site Adminictration

and executlon.

Day 3 (in addition to Days 1 & 2)

ent Migration

A typical on-site agenda

content migration.” —Kally Nislsan, Peoria Unified School District, AT

.

¥

/f “This training was extremely helpful to get us started on our l
1

22



Creating Accessible Word Docui 3 copy

checklist for improving your Ally score |‘_ﬂ"|:| Paste Opﬁom:

75 &

& add built-in Headings to document and do not skip numbers (e.g. jumping
from Heading 1 to Heading 3)
Use built-in List options [2.g. bullets or numbers)
Links should be descriptive text
Add Al Tast for all images
Define Table Headers and simplify Tables as much as

Images

Save as Picture...
©Bd ChangePicture >
IH Group >
rl:_l_, Bring to Front >
%y

Helpful Information: Send to Back 5
hitps://help blackboard.com/Web ¢ i inistrator/Accessi =
https://support office.com/en-us/article /accessibility-support-for-word-cotadab  C@y Link >
5 285663f3343¢
Alternative Text = R—
A Wrap Text >
Tolmn 1 s b= Edit Alt Text...
H Row 1 abcdef abcdef Enly .
eCO rat|Ve Row 2 abcdet abcast =Ll Size and Position...
Row 3 abcdef abcdef
< Format Picture...

L B e B e e T

Document

Alt Text

How would you describe this object,
someone who is blind?

(1-2 sentences recommended)

Iimping

Cveral aseasalbary score

Mark as decorative @

92%

rator/Accessibility
vord-c014d8b8-4ef3-4a7a-935d-

23




Tables (1 of 2)

Tables organize information and help you show relationships
between things.

* Avoid using tables for layout.
* Nested tables, split cells, or merged cells can trip up accessible devices.

* Navigate your table using the Tab Key

24



Tables (2 of 2)

File Home Insert Design Layout References Mailings Review View Help Table Design Layout

Blietole s o ceco- c-oo- EEEER oooEm oem mmmew %
[] Total Row [ Last Column -EEEE -EEEE EEEEE |EEEEE ) EeEEEE EEEEE =EEE= ———
__________ e e e e e e e e e ey Shadmg
[v] Banded Rows [ | Banded Columns v -
Table Style Options Table Styles

When adding content to a table
* Use a Built in Table Style
* Designate the Header row and First Column (as necessary)
* Modify the Table Properties as necessary.

* Add Alternative Text

25



* |dentify and Select the Header Row
*  Modify the Table Properties
* Repeat as Header Row
* Add the Table Alt Text and Description

Table Properties

Table Properties ? X
Table Row Column Cell Alt Text
Row 1:
Size
D Specify height: 0" l;l Row height is: .
Options

D;AHDW row to break across pages.

Repeat as header row at the top of each page

|A Previous Row | | w Next Row

3
X

Table Properties

Table Row Column cell

Title

Description

Alternative Text

Titles and descriptions provide alternative, text-based representations of the
information contained in tables, diagrams, images, and other objects. This
information is useful for people with vision or cognitive impairments who may not
be able to see or understand the object.

Atitle can be read to a person with a disability and is used to determine whether
they wish to hear the description of the content.

oK | | Cancel

26




Before Saving your File

v'Set Language v'Set Language
v'Title v'Title

v'Save as .docx A WIEICRERES
v'Save as PDF




Setting the
Language using the
“Review Menu”

(WINDOWS) &

Thesaurus

Proofing

Home Insert Design Layout

52 Al

ih,«': Check Docurnent

533 Word Count

R L

Read Check Translate Language

Aloud | Accessibility = =

Speech Accessibility Language
e

References

Mailings Review View Help
— —_— . | —h
Language ? et
Mark selected text as:

English (United States)
Afrikaans

Albanian I
Alsatian (France)

Amharic

Arabic (Algeria)

Arabic (Bahrain)

Arabic (Egypt) W

The speller and other proofing tools automatically use
dictionaries of the selected language, if available.

D Do not check speling or grammar
Dgtect language automatically

st e



@ Word File Edit View Insert Format Tools Table Window Help

AutoSave @ o @A H

Setting the Home Insert Draw Design Layout References Mailings Review  View
Language using the IR \ARNFNE-1-T 7 S v e
“Review Menu”

Spelling & — Read Check Translate Language Mew Delete Resolve l‘_'| Mext
Grammar ~ Aloud Accessibility Comment

| 3

Language

Mark selected text as:

|VI Arabic

dC
Afrikaans

Arabic
Basque (Basque)
Bosnian
Bulgarian
Catalan
Chinese (China)
Chinese (Taiwan)
Croatian
Czech
Danish
Dutch
The speller and other proofing tools
automatically use dictionaries of the
selected language, if available.
Do not check spelling or grammar
Detect language automatically

Default... Cancel

29




Setting the Title Info

Sample_Word_Document
E New Downloads

(Wi ndOWS 5 Open | 5 Upload | | | Share | |(—<>_) Copy path | |E:' Open file location

Info

Save

E Protect Document Properties ~
Save As CS Control what types of changes people can make to this document. Fm 92.2KB

Pages 1
Words 120
Total Editing Time 348 Minutes

Print

Share

@ Inspect Document Title ENTER TITLE HERE
Export Before publishing this file, be aware that it contains: Tags Add atag
Check for o

Document properties and author's name

" Headers

®  Customn XML data

= Content that people with disabilities are unable to read

Comments Add comments

Transform

Related Dates

Close Last Madified Taday, 1:17 PM

Created 1/14/2020 7:28 AM



Setting the Title

WE

.

Home

Word

Insel

Sample Word Document Decorative Image.docx Properties

-M Statistics  Content  Custom |

Title: | ENTER TITLE HERE]

Subject:
Author: | Blackbeard Trainer
Manager:
Company:
Category:
Keywords:

Comments:

Edit View Insert For
New Document N
New from Template... {+3P

Open... ®O
Open Recent »

yperlink base:

Template: Mormal.dotm

e preview picture with this document

Close #|W
Save ®S
Save As... {4#S
Save as Template...

Move...

Rename...

Cancel

Share »

Always Open Read-Only
Restrict Permissions »>

Reduce File Size...

Page Setup...
Print... 8P

Properties...

31



Save as .docx
and close the file

32



Save as a .pdf

v" File > Save As
v" Save As > PDF

v' Options, mark
Document structure tags
for accessibility

- —

@ Documents o Date maodified Type Size
or WCM_Training S icators and Ico..  2/12/2020 8:03 AM File folder
= This PC 1/24/2020 11:50 AM File folder
DCShares 3/25/2019 3:28 PM File folder
fT/2020 3:33 PM PDF Fi 57K
i Desitop 2/7/2020 3:33 e 57 KB
L 4 b .
N Al -ample Word_Document.pdf]
Save as type: PDF (*.pdf)
Authors: Blackboard K-12 Traini... Tags: Add atag
Optimize for: ) Staﬁdard {pu!.;!lis.hr'ng Options...
online and printing)
@ Minimum size [[] Open file after publishing
{publishing online)
Options
~ Hide Folders Tools -
Page range

@
O Currgnt page
Selection

Cl PBQE!SJ Fram:

*

To:

4

Publish what
® pocument
Document showing markup
Include non-printing information
Create bookmarks using:
Headings
Word bookmarks
Document properties
Document structure tags for accessibility
PDF options
PDF/A compliant
D Optimize for image guality

Bitmap text when fonts may not be embedded

Encrypt the document with a password

Cancel



Edit View Insert Forr

New Document e N
New from Template... {3P
Home Insel Open... ®¥0
Open Recent (2

abc
(Mac) v/ Close 3B\

Spelling & =—
Gramimar == Save 36 S

Save As...
Save as Template...

Save as a .pdf

File > Save As

File Format > PDF

Best for electronic

e e e Online Locations File Format: | PDF o
distribution and — ~
s ene © Best for electronic distribution and accessibility
accessli b| I |ty. (uses Microsoft online service)
(" Best for printing
Hide extension New Folder Cancel m
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Instructor Feedback — View Your Improved Score

* Upload the corrected File

* Ally will immediately Score the new document.

* INSERT SCREEN CAPTURE OF THE IMPROVED SCORE

35



PowerPoint

36



Choose or Create an Accessible Slide Design

* Use Pre-formatted Layouts
* Initiate the Accessibility Checker
* Color Contrast

* Use a larger font sizes
(18pt or larger)

37



Slide Titles

* Using the Built-in Layout
* Unique Slide Title
* Verify in the Outline View

Title Slide Title and Content Section Header Two Content Comparisen

Title Only Blank Content with Caption Picture with Caption  Title and Multiple

1_3 Colurnn

1_Title and Cantent 1_Title Only 1_Picture with Capticn Panoramic Picture

with Caption

NOTE:
The Ally document check enforces a minimum of 1 title for every 7 slides in a PowerPoint document. 32



Text Order

s Slide Show Review View Help
. = gy & Shape Fill ~
vl?vAAA::_:_:Eh Ic -
[~ ShO ALD _{4 r_-dihape Outline
- - - - = = = = apes SRR Luic .
Aa ﬁ ﬁ = = = = = - P i e~ & Shape Effects ~
t = Paragraph ] Order Objects
UEEYY FEUTTIE PR R P PR A IRTNIRNT RTINS TRRY PR PR
B, ong:
DD Show All || Hide All
Text Order . .
B BringE D Text Placeholder 6
L_‘D end B Content Placeholder 5
T B Content Placeholder 4
—— Group Objects Title 3
I8 Group
o
&
Position Objects
Use the VIEW SELECTIOM PANE osition
{Home, Arrange) to organize your content. = Al 3
(This text was added 3rd and is MOT as an independent text box) e algn
1 Rotate >

' Selection Fane.. e OUTLINE VIEW to organize your content.
2
¥

— Use the SELECTION PANE (Home, Arrange) to organize your content.
— Reading order is BOTTOM to TOP (Layers)

— You may hide Objects visually, but still read by Screen Readers

39



Links, Lists & Images

* Links
— Descriptive Text (for sharing electronically)
— Descriptive Text and Short URL (for sharing electronically and as a printout.)
— Screen Tip
* Lists
— Use Built in Paragraph List Tools
* Images

— Alternative Text or Mark as decorative

40



SmartArt Graphics & Shapes

It is also suggested to
* Add Alternative Text or Mark as Decorative.

* Avoid Unrelated Graphics, Shapes, etc.

Themes | Variants | . Customize | Designer | ~

E. -I----ﬁ---I---S---I---q---l---3---I---E---I---‘I---I---u---l---‘]---I---E---I---B---I---4---I---5.---I---6---I- E
Alt Text v X%

SmartArt Graphics & Shapes
B O
- 5 steps for how te use Ally and your files,
- Step, Upload Your File; Step 2, Ally Scans
- and Scores...
< Upload Your Ally Scans and Correct Upload Your Ally Re-Scans
B File Scores File COriginal File Corrected File & Scores
o
: [ Mark as decorative ()
B o
m 3
- ¥

41



Charts

When using Charts & Tables, it is suggested to
— Check Color Contrast
— Add Alternative Text
* Enter most important on first line

* Be as concise as possible

T Y D B P R RN PEET P PR TN PR NN SN R SR Y S PN SR PURT- SN R P |

Alt Text

How would you describe this object and

cantext to someone who is blind?

_ ? Change ino;"y Scores Q (1-2 sentences recommended)
B Charts & Tables N

Color Contrast -
':_ Add Alternative Text -
- - Enter most important on first line -
N - Be as concize as possible
o o= O
: L ' | Mark as decarative
H -
':_ m
- :
b Dacument FowerFolnk
R mBadre ampiify B Aferamplfy
: o O O ~
- %
- ¥
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Tables

Ssign Transitions Animations Slide Show Review View Help Table Desgn Layout

EEpy  Ey——— ﬁ«‘-hﬂdlﬂg ”

[— — — — | — — — — I — — — — |
I EEE = EE

@ Effects ~

Home Insert

Header Row First Column
[] Total Row [] Last Column
[ | Banded Rows [_| Banded Columns

Table Style Options Table Styles

* Color Contrast

* Choose a built in Table Design

* Use simple table structure

* Specify column header information
* Add Alternative Text

* Tables should not contain split cells, merged cells, or nested tables
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Before Saving your PowerPoint File

v'Title v'Set Language

v'Save as .pptx v Title
v'Initiate Tags
v'Save as PDF

.
=
O
ol
S
Q
=
O
ol




Instructor Feedback — View Your PPT Improved Score

Re-upload the File.

Test linking the original to another place

Upload new file w/ diff name

Check if the link works

INSERT SCREEN CAPTURE OF THE IMPROVED SCORE

45



Evaluate and Improve for Web Friendly

MS Word

Improper use of headers.
Incorrectly built lists.

Empty links or links without
descriptive text.

Missing alternative text tags in images.

Using tables incorrectly.

Color contrast issues.

PowerPoint

Improper use of headers and slide titles.
Incorrectly built lists.

Empty links or links without
descriptive text.

Missing alternative text tags in images.
Using tables incorrectly.

Color contrast issues.
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Amplified Series Information

https://cerc.blackboard.com/amplify



https://cerc.blackboard.com/amplify

Thank you for attending today’s
Amplify Series Session.

Blackboard
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